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POST DATA EXCHANGE FINAL M E M O:  UPLOAD INSTRUCTIONS
To:
Data Manager
NHP or CDC
CC:
Botanist

Zoologist
From:
Donna Reynolds, NatureServe
Date:
16 July 2010
Re:
Element Tracking Database Update 



We have now completed the data exchange for the NHP OR CDC NAME. This memo provides instructions on how to update your global and national element files with the changes that occurred in the exchange process.  We also document the updates that occurred to your data during the data exchange.  Please provide copies of this memo and the attachments to NHP/CDC staff as appropriate.

Please note that it may take a week or more to upload your post-exchange updates.  The process is considerably more complex that it used to be under BCD, although we are working to streamline it as time goes on.  Much of that time involves waiting for Exchanger to run certain steps, so you can work on other things in the meantime—but the overall process, start to finish, does take a while.

Thank you in advance for your cooperation and hard work in completing this process!
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SUPPORT INFORMATION:
For help with your exchange please submit questions and technical issues to the NatureServe Support site at http://support.natureserve.org.  Thank you.
Data Exchange Upload Summary and Overview
Overview (Checklist) of uploading post-exchange updates:

___ 1) Unzip all report templates, rule sets and rules criteria files that NatureServe sent to the appropriate folders in the Exchanger install directory (see page 3).
___ 2) Check the overall health of your database to ensure it is ready for the exchange (pp. 3-4)
___ 3) Perform type 1 and type 2 element deletions, including reparenting EOs if necessary (pp. 5-6).
___ 4) Load the zipfile project from NatureServe.  This loads records into the holding area, and synchronizes your UID fields with those in NatureServe’s database (pp. 6-7).
___ 5) Run the "analyze tables" SQL statement to optimize Exchanger performance (p. 8).
___ 6) Match & commit domain table values.  This step ensures that incoming lookup-table values are correctly matched up with ones in your target database (pp. 7-8).

___ 7) Match & commit supporting records.  These are skeletal records that are automatically exported because they are referenced somewhere in the exported data.  Mostly, you will just reject these supporting records (p. 9).

___ 8) Match, apply rules, and commit references (pp. 9-10), then higher class units (p. 10).
___ 9) Match, apply rules, and commit scientific_names (pp. 10-12)

___ 10) Match, apply rules, and commit Element Groups (p. 12).
___ 11) Match & apply rules to element_global records.  Run element global reports then commit element_global records (pp. 12-14).
___ 12) Match, apply rules, and commit element_national records (p. 14).

___ 13) Match & apply rules to element_subnational records.  Run reports, then commit element_subnational (pp. 14-.17).
___ 14) Perform type 3 element deletions, including reparenting EOs if necessary (p. 17).
How do I get into the Exchanger Tool?

Double click on the b4importtool.bat icon.  Sign In. Once you’re in the Project View and have loaded your data, double click the Project with the name of your data exchange and a new view should open that shows your records.  You will see the different table types in the project tree such as Domain, Supporting and Logical.  Click on the pin next to Logical to see the different logical record types.  You will be highlighting the Scientific Name table or the Element Global table etc., depending on which table type you need to work on.

Exchanger Training Opportunities:  If you are a new Exchanger user or if it has been awhile and you need a refresher, it may be extremely helpful for you to complete the Exchanger Basics Demo and /or the Exchanger Online Tutorial found on the Biotics Support website at http://www.natureserve.org/prodServices/biotics/HDMS-DataExchange.jsp and underneath the ‘Training and Additional Information’ heading towards the bottom.  Also, if you are curious about what is actually happening during the upload process, please read the Conceptual document that is also included in this area of the Exchanger support website.    
Tips: 
1. While doing any of the matching steps, if you see records with MATCH_FAIL, try re-matching before spending too much time trying to figure out why the records did not match.  If records are COMMIT_FAIL, try re-committing because a different record (now committed) may have been preventing the commit the first time..
2. If a record fails any of the steps (match, import rules, commit) there will be a note at the top of the record explaining what failed.  Open up the record and review the note; it may help you resolve the problem.  If the note states that a child record failed, then look at the note of the failed child record.  The failed child record should have an icon in the left screen similar to the parent record’s icon (exclamation point indicates a failed record).  Please see p. 18 of the appendix for instructions on how to resolve the most common of commit_fail errors.  

3. There are a lot of different pre-programmed templates for matching and applying rules. Be sure to choose the one specified in the directions. Using the wrong matcher or ruleset can result in errors that you'll need to resolve or may prevent the incoming information from being uploaded into your database.

4. When matching records below, many times you will be prompted to use the Generic Matcher.  Some installations of Exchanger may have this matcher listed as the “Default Matcher.”  They are the same thing.
5. Check the KnowledgeBase for Exchanger-related topics. Some useful KB articles are #s 542 and 543 (explanation of the green and red "thumbs" icons), 592 (conceptual explanation of what Exchanger does), and especially 593 – the Quick Reference Guide or "cheat sheet."  
Data Exchange Upload: Detailed Instructions
1) Unzip the attachments that NatureServe sent.

The zip file should contain the following files:

· XX_post_dx_data_DDMON2010.zip (the data that will be imported)

· Final Memo (this document)

· Botany memo

· Zoology memo and supporting documents
· rulesets.zip

· rulecriteria.zip

· report_templates.zip

· grank_different_from_NatureServe.xls
It's important that the following files are put in the correct subdirectories, which should already exist on your computer.  Note: these files go on the Exchanger client machine, not the login server.  The directions assume that Exchanger is installed to the C:\Exchanger\b4dx directory; if this is not true for your installation, please substitute the path where your Exchanger client is installed.

1. Unzip Rulesets.zip to \Exchanger\b4dx\rulesets\

2. Unzip Rulecriteria.zip to \Exchanger\b4dx\rulecriteria\

3. Unzip Report_Templates to \Exchanger\b4dx\reports\templates\ (NOTE: Make sure you put them in the templates folder under reports, not the one directly under b4dx)
4. Do not unzip the post-exchange XML data files (XX_post_dx_data_DDMON2010.zip); the zipfile will be used intact in the \Exchanger\b4dx folder.

2) Check for Missing Constraints 
NOTE: You can skip this step unless you have done a physical server migration or rebuilt your database from a backup file since the last time you checked constraints (probably, your last data exchange). If you have, this step is essential.

To check your database for the proper constraints, we've put together a simple procedure that you can use anytime. Please refer to the Biotics Web Site and go to either to the Data Model page or the Data Exchange page. They link to the same package that you can download. If you have any questions about this procedure, open up a Product Support item with your question.
3) Check for Invalid Objects

1. Go to the Knowledgebase and search for Article ID Biotics 263 or the following text:  ORA-24372 Invalid Object for describe 
2. Follow the instructions included in this Knowledgebase ticket. 
4) Database Preparation and Tuning Steps
1. If you did a Biotics 4 exchange with NatureServe last year, you will have to run a few cleanup steps to be sure your holding area tables are ready to go.  It is very important that you do this cleanup because if your tablespaces get full the "load" step may fail!

2. Open B4ImportTool (double-click on B4importtool.bat), and log in with your Biotics 4 user name and password.  This will bring up the project view.

Note: Some programs have found it useful to create a new database user with which to log into Exchanger.  This allows them to more easily use the Biotics 4 audit logs to track changes made during the exchange.

3. If an old data exchange project is there in your holding area, you will need to purge that data first.  Single-click on the import project to highlight the row; then click the Purge button at the top of the window.  Note that it's best to purge the project overnight, since purging the project may slow down Biotics for other users.  

4. You will now need to check the size of some table spaces.  Please check to be sure that the BIOTICS_DX_DATA and BIOTICS_DX_INDEX tablespaces are both 900 Mb in size.  If you need help on how to check tablespaces, there are instructions in the Knowledge Base (Article Biotics464, "How full are the table spaces?" under System Environment ( Oracle, and Article Biotics492, "Tablespace Administration," under Biotics 4 Exchanger ( Admininstration). 

5. When the project is purged, you can close the Exchanger import tool.

6. Run the following SQL statements after purging your old import project:


exec dbms_stats.gather_schema_stats (ownname => 'BIOTICS_USER', cascade => true);


Then log out as  biotics_user and re-log in as the biotics_del user to run the following command:


exec dbms_stats.gather_schema_stats (ownname => 'BIOTICS_DEL', cascade => true);

5)  Delete element records listed in science memos underneath the Type 1 and Type 2 deletions. 

Please refer to both the botany and zoology memos (included in the zipfile delivered to you) for lists of elements that should be deleted from your Biotics database.  

Type 1:  Normal Deletions
1. Please check both science memos to see if you have any Type 1 deletions.  If you have any of these deletions, please continue with the following steps.   

2. Perform these steps BEFORE processing data in Exchanger.

3. Check to be sure that no EOs or Source Features are attached to the element.  These could have been added by your NHP or CDC while NatureServe had your data.  
4. Open the Tracker application, and find the Element Global Tracking records listed in the memos.  When you are searching for an Element, be sure to have the ‘all levels’ and the ‘include related scientific names’ options chosen.  This way you can also see related infra-specific species that you may want to know about.  Open the first EGT by double-clicking on the row.

5. Check for EOs.  Under the File menu, choose Open ( Element Occurrences.

6. If any EO records are opened, please go to the Type 2 deletion instructions below and follow those steps.  

7. If a "no related element occurrence records" dialog box comes up, check for Source Features.  File menu ( Open ( Source Features.

8. If a "no related element occurrence records" dialog box comes up, you can proceed with deleting the element.
9. In some cases you will be unable to delete a species because the global record is the parent for infraspecific taxa in your database.  In that case, you should delete ONLY the EST-level record and leave the global and national records in your database. To delete the EST, start from the EGT record and select File - Open - Element Tracking - Subnational. Under the Edit menu, choose Delete.  Click 'Yes' to confirm the delete.  
10. NatureServe is aware that deleting records at the beginning of a data exchange upload can come with some apprehension.  Therefore, below are two options that are always available for preserving or recovering data.  

a. Recovering data using the deleted schema.  This is not a straightforward or easy process, but if a mistake is made, the data can be completely recovered in its original state.  If you have strong reservations for not deleting the records indicated and you believe you will probably want to keep some or all of the records, then please choose the next option.

b. Exporting records from your Biotics in order to preserve them.  If you are apprehensive about deleting records before you complete the upload process, you can follow some instructions (located in the Appendix of this document) on how to export them out of Biotics in order to preserve them in the event that you decide later that you need them again.  If you wish to complete this option, you must export the records out of Biotics before you proceed with the deletion steps below.   

11. Delete the element.  Under the Edit menu, choose Delete.  Click 'Yes' to confirm the delete.  The associated ENT and EST will also be deleted as well as any child tables of EST, including ESR and CAS.  Please see a note about problems deleting elements in the appendix of this document.    
12. Repeat these steps for all elements listed in the Botany and Zoology memos under the Type 1 deletion category.
Type 2:  Deletion where new EO parent exists
1. Please check both science memos to see if you have any Type 2 deletions.  If you have any of these deletions, please continue with the following steps.   
2. Perform these steps BEFORE processing data in Exchanger.

3. Element deletions that appear in these lists have EOs and Source Features attached to them.  These EOs and Source Features must be re-parented before the deletion can take place. 

4. Open the Tracker application, and find the Element Global Tracking records listed in the memos.  When you are searching for an Element, be sure to have the ‘all levels’ and the ‘include related scientific names’ options chosen.  This way you can also see related infra-specific species that you may want to know about.  Open the first EGT by double-clicking on the row.

5. Check for EOs.  Under the File menu, choose Open ( Element Occurrences.

6. If any EO records are opened, you must re-parent these EOs before proceeding.  You can re-parent EOs in Tracker.  Please follow the instructions in the appendix of this document (re-parenting an element occurrence record) if you need help with this.  
7. If a "no related element occurrence records" dialog box comes up, check for Source Features.  File menu ( Open ( Source Features.

8. Please re-parent all Source Features using a SQL update command before proceeding. The command will have the following structure: 

update source_feature set element_subnational_id =  xxxx, rec_last_mod_user = 'username' where source_feature_id = yyyyy
9. Once re-parenting of all attached EOs and source features is completed, you may now delete the element. Under the EGT Edit menu, choose Delete.  Click Yes to confirm the delete.  The associated ENT and EST will also be deleted as well as any child tables of EST, including ESR and CAS.  
10. Repeat these steps for all elements listed in the Botany and Zoology memos under the Type 2 deletion category. 
11. When the necessary EO reparenting has been done for all Type 2 deletions, see KnowledgeBase article 391 for the script and instructions for running the Fix_EO_Num procedure. Running it will ensure that the "next eo num" is up to date for all elements and will prevent possible error messages in Mapper. If you've already installed the procedure, in SQL+ type:

SQL> SET SERVEROUT ON
SQL> EXEC FIX_EO_NUM
If you have any Type 3 deletions on either of the science memos, please wait to perform these until you have committed all of your data in Exchanger.  Instructions for these deletions will occur at the end of this document.  
Deletion Note:  Do not be confused if some of the deletions above come back in as new EGTs and ENTs when you upload your data.  We send back EGTs and ENTs for elements related to elements you have the ESTs for.  Examples are related Parent Species and related Standards.
6)  Load the import project

First, please read these three things about loading the import project.  

1. It could take as much as 5-7 hours for the entire load (or longer for programs with a slower server or network), and it can slow down Biotics Tracker significantly—probably best to start it near the end of the day so that it mostly runs overnight.
2. Also, it is wise to notify your database administrator that you will be doing this load so that he or she does not perform the nightly backup or something that will interfere with your load.  The DBA could start the backup a little later in the day, or even early the next morning so that it is less likely that it will interfere with your load.

3. Also, at the very beginning of the load process the UID synchronization will automatically take place and will synchronize the UID fields in your Biotics 4 database with those in the central NatureServe database.  Any record that your program sent to us for data exchange could have its UIDs changed.  Fields that may be affected include: ELEMENT_GLOBAL_SEQ_UID, ELEMENT_GLOBAL_OU_UID, EO_SEQ_UID, EO_OU_UID, CONSERVATION_SITE_SEQ_UID, etc.  These are not the primary key fields, just two fields per record that give a network-wide identifier for all records.  See the "UID Synchronization" ticket in the KnowledgeBase for further details; search on UID.
PLEASE NOTE that the process of updating the UIDs will change the rec_last_mod_date and the rec_last_mod_user for any records where a UID field gets changed.  If this is your first data exchange since you converted to Biotics 4, the rec_last_mod_date and rec_last_mod_user may change for the majority of your EGTs, ESTs, EOs, etc.  Please keep this in mind if, for instance, you have reports that rely on the rec_last_mod_date or rec_last_mod_user.

1. Open B4ImportTool (double-click on B4importtool.bat), and log in with your Biotics 4 user name and password or a specific username and password you might have set up specifically for uploading data exchanges.

2. Project ( Load ( Load Export Project, and when prompted, choose the post-exchange update zip file sent to you by NatureServe (XX_post_dx_data_DDMON2010.zip).

3. Fill in the project properties

3. project name (**required**)— whatever you want to call it, but no spaces are allowed

3. subnation cd = the two-letter abbreviation for your state or province (e.g. CO for Colorado, or SK for Saskatchewan)
3. nation cd = CA for Canada, US for United States

3. Last exchange date = the date you exported your data files for this year's data exchange (see the date/time stamp on the zip file generated by the Exchanger Export Tool).  If in doubt please contact the Conservation Database Specialist listed on the first page.
3. ref cd suffix = the four-letter suffix that identifies references belonging to your subnation (e.g. MIUS for Michigan, SKCA for Saskatchewan, etc.)

3. database type = B4
4. Hit okay & wait. Don't panic… it will take a while to do the UID updates before a progress bar appears.  The application will appear to be frozen, but it's really just busy.  It could be 15 - 30 minutes before the progress window shows up.

If you get an error that interrupts the load process—close the progress window.  It will ask if you want to cancel the interrupted project; answer No, and contact NatureServe by submitting a BridgeTrack item http://support.natureserve.org for help on how to re-start the load.  Please include the error message received and any new log files found in \Exchanger\b4dx\logs after closing Exchanger.
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7)  Analyze your Oracle tables.

Oracle will periodically "analyze" the database, and calculate statistics on each table.  It uses these statistics to help optimize queries so that it can run more efficiently.  When you import your data into the holding area tables, it increases their size quickly, and it's important to have updated statistics so that Exchanger can run as fast as possible.  If you need instructions, please see the Knowledge Base (Biotics 4 Exchanger ( Admininstration ( Improving Exchanger performance) or simply run the sql statement below.
exec dbms_stats.gather_schema_stats (ownname => 'BIOTICS_USER', cascade => true);
This is the same statement that you were asked to run after purging your old project. You need to run it again, but you do not need to run it for BIOTICS_DEL this time.
8) Match & commit domain table records

The first step is to make sure that the lookup-table values are properly matched up. Look up tables are domain tables used in the Biotics Tracker interface to populate drop-down menus.  Each value in a drop-down menu corresponds to a specific domain table record. These values need to be matched before proceeding.  Mostly, no changes will be made to target records; it is primarily just to match the incoming values with target values.

1. Double-click on the row for the project you just loaded—this will take you into the browse view.  Click on the key next to Domain to view the domain tables in the project.

2. Right-click on the Domain folder in the tree (the left-hand side of the display); choose Match, and then hit "Yes" to use the Generic domain matcher for all tables.  
3. When the match finishes, hit “close” to return to the browse window.  
4. On the domain portion of the tree, expand the domains to show all domain tables.  
5. Highlight the first domain table and hit the red Refresh button, and then look at the text in the match-status column for this table as well as the rest of the domain tables.

6. Matched records are okay—no action is needed, and no changes will be made to the target domain tables.  Most values will match, because your domain tables are updated by running the Biotics 4 patches.  You can run the following sql in a database tool in order to find Domain tables with records that are either new or partial matches.  
select imd.table_name, count(*)

from import_detail imd

where imd.REC_TYPE = 'Domain'

/* and imd.IMPORT_PROJECT_ID = 630 */
and (imd.MATCH_STATUS <> 'MATCHED'

or imd.IMPORT_STATUS <> 'REJECT')

group by imd.table_name;

7. For any partial matches: you must either accept the partial match, or set the domain value to NEW (see instructions in the Appendix).

8. Most NEW values (except keywords, watersheds, and mapsheet values) will get rejected by default.  You should browse through the domain tables that resulted from running the above sql query one-by-one and take a look at any new values—make sure that they really are new (using select statements to view what is already in your database for a particular domain), and that you do not already have a conceptual match in your database.  If a value is listed as NEW but you think it does match a value in the target database, you’ll have to do a manual match (see instructions in the Appendix).

9. If you should want to add any of the new values to your database, open up that record and click on each of the red thumbs-down icons—they'll turn to green thumbs-up, indicating that you want to accept that data (a green thumbs up tells Exchanger to accept that change when the record is committed to the target, in this case the target is your Tracker database).  There is one icon at the top of the record, which corresponds to the record itself; the icon next to each field corresponds to just that one field.  Example: NatureServe has added a new value to d_usesa; if you don't add the new record to your domain table by changing the red thumb to green, the USESA field in the incoming element_global will get a null value and you will lose that global-level USESA information.

10. Exception: all keyword domain tables, d_watershed, and d_mapsheet are set to accept new values by default.  If you want to reject any of those new values, see the Appendix for instructions.

11. Once you are satisfied with the status of the domain tables, right-click on the Domain key and choose "commit" to make any changes in the target database.
12. Any domain records that you want to insert into your database must be committed before you can proceed.
9) Match supporting records in a specific order
Supporting records are skeletal records that automatically get sent with an Exchanger export project, because they are referenced somewhere in the project.  For example, if you export a conservation_site record and include the element_site child table, Exchanger will include supporting records for the element_global records that are listed in element_site.

1. Supporting records must be matched in this order: Reference, Scientific Name, Element Global, Taxon Global, Element National, Element Subnational.  You may not have all of them, but for each of these types that are present under your Supporting folder, complete these steps before processing the next record type.

1. Highlight the table name in the tree so that the view goes to those records.  

1. Check the ‘All Records’ checkbox in the right window, and click the Match button in the right window (Ensure that the filter dropdown says 'none').

1. Hit OK to choose the matcher called either “Generic” or “Default.”  Wait for the match to finish, and then hit Close.

1. If these match something in your database, that's great; if they don't, you should just reject any new records (the default action).

1. If any are partial matches or match-fails, you can reject them manually (see Appendix).

1. When all records show a new, matched, or reject status in the MATCH_STATUS column, you're ready to commit them. Right click on the Supporting folder and select Commit. All supporting records must be committed before you move on.
2. Be sure to match and commit all supporting records before proceeding.

{In steps 10-21, remember to look in the appendix (p. 18) for solutions to the most common COMMIT_FAIL errors.}

10) Match, apply rules, and commit References:

1. Expand the logical records folder by clicking the pin next to Logical.

2. Click on the REFERENCE page in the browse tree; check the ‘All Records’ checkbox in the right window; and click the Match button in the right window (ensure that the filter dropdown says 'none').  Hit "OK" to choose the matcher called either “Generic” or “Default.”
3. If any say match_fail in the ha_rec_status column, re-match just those records.  You can sort the ha_rec_status column by clicking on the column heading TWICE and look for match_fail records following the "new" records. Preferrably, you can create a Filter to check for match_fail records. (See the "Use Filters" section in Biotics Exchanger Help, which can be accessed through Tracker or Mapper). Select any match_fail records, and click on the Match button at the top of the window.  They should now say match_done.  If there are any other match_fail records, check for errors in the DOS window.  Contact NatureServe support to get help on errors in the DOS window. (http://support.natureserve.org ).  Make sure when submitting your ticket that you copy the error from the DOS box into the support item.

4. Apply import rules: click on the REFERENCE page, check the All Records checkbox in the right window, and click the Apply Rule button in the right window (Ensure that the filter dropdown says 'none').  Select the references ruleset called "dx_NHP_import_from_NatureServe"; this accepts new records and updates to matched ones.  However, references that belong to your subnation will be protected—they will be set to ‘reject’ and no changes will be made to references whose codes end in the suffix you provided in the project properties above (e.g. if New York entered NYUS, any changes to references whose codes end in NYUS would be rejected).

5. Check for records that don't say RULES_DONE (or REJECT) in the HA_REC_STATUS column; you can do this by sorting the column.  If there are any, re-apply the rules to just those records.  Finding records without RULES_DONE can also be done by creating a filter (Tools ( Filter Management).  Sorting hundreds or thousands of records can be time consuming and creating and applying a filter usually takes less time.

6. Commit the references: click on the references page in the browse tree, check the All Records checkbox in the right window, and click the Commit button in the right window (Ensure that the filter dropdown says 'none').

7. Make sure all records have a COMMIT_DONE or REJECT record status (rec_status) before moving on.

11) Match, apply rules, and commit Higher_Class_Unit:

1. Match all records, using “Generic” or “Default” Matcher.  If any say match_fail, re-match.  All records should get NEW or MATCHED status.

2. Apply import rules: click on the higher_class_unit page, check the All Records checkbox in the right window, and click the Apply Rule button.  Open the ruleset “dx_NHP_import_from_NatureServe"; this accepts all new records and updates to matched ones.

3. Commit: click on the higher_class_unit page, select the All Records checkbox, and click the Commit button (Ensure that the filter dropdown says 'none').

4. Make sure all records have a ‘commit_done’ rec_status before moving on.

12) Match, apply rules, and commit Scientific Names

1. Match all records, using the “Generic” Matcher.  The Generic Matcher may not be the first matcher on the list of options for scientific_name; you have to choose Generic Matcher from the drop-down menu.  

2. Click the REFRESH button (you will have to select REFRESH throughout the process after any steps have been run or after any records have been updated in order to find the records that did not match.  Refreshing a browse forces Exchanger to update the statuses.  Another way to find the scientific names that did not match is to create a filter that searches for scientific names without MATCH_DONE.

3. Resolve matching issues until all records have a match status of NEW or MATCHED, and a record status of MATCH_DONE.  You can find these by sorting the rec_status column—click on the column header to sort.

a. Resolve any PARTIAL_MATCH.  You may see some partial matches on alternate keys only, or on UIDs only.  Any records that match on scientific name but not author—check the candidate match to be sure (see Appendix), but it's probably okay to accept these suggested matches since the biologists have reviewed these.  Select “Set as Match” to match record.  Say Yes to Match Children question and choose ok to select Generic Matcher.  If it matches on UID but not alternate keys, you should consider that a new record; choose NEW from the matching menu.

b. Resolve any NOMATCH and MATCH_FAIL.  Open record and under the “Matching” menu select New (if you want to add to scientific names table), Reject, or Manual Match (must look up scientific name ID for correct name in Biotics).  After you enter the new ID - this Id is the primary key id, i.e. scientific_name.scientific_name_id displayed in Biotics Tracker - select ‘Details’ to double-check that this is the correct record. 
4. Review and resolve any "collision" matches.  Exchanger will allow two incoming records to match to the same target record.  Obviously, we don't want this to happen for element records, so follow these steps to be sure you don't have any.

a. Find the column called HA_NOTES.  Sort this column (ascending) by clicking on the column header; re-sort (descending) by clicking again.

b. If any records have a collision, you will see this note: WARNING: multiple incoming records have been matched to this target record! 

c. If any of your scientific names have a collision match, please contact the NatureServe science staff to consult.  Check in the botany or zoology memo to find contact information— you should directly contact the scientist listed in the appropriate memo.  Please note that once you resolve the collisions, the actual WARNING does not go away.  
5. Apply import rules.  To do this, click on the checkbox next to "all records" at the top of the window, then hit the Apply Rule button with the filter set to None.  Choose the ruleset called "dx_NHP_import_from_NatureServe," which accepts all inserts and updates to scientific names.  If you want to reject a record for any reason, see the Appendix for instructions.

6. Select REFRESH to update the import status and find names that don’t have an import status of CommitReady or Reject.

7. Resolve import issues until all records have a record status = Reject or CommitReady.  You can find these by sorting the rec_status column—click on the column header to sort, or create a filter to find these records.  Ignore the records that failed the match due to synonyms as we mentioned above.

8. Commit scientific name records: check the “all records” checkbox, and choose Commit with the filter set to ‘None’. 
9. Select REFRESH.  Please check to make sure that all scientific names are committed before moving on to the Element Global match.

10. Resolve any records with record_status = Commit_Fail.  All records that are not still match_fail should have a record_status = COMMIT_DONE.

13) Match, apply rules, and commit Element Groups

1. Match all records using the Generic Matcher.

2. Select REFRESH

3. If any records are match_fail, try re-matching until all are NEW or MATCHED and have a record_status of MATCH_DONE.

4. Apply ruleset "dx_NHP_import_from_NatureServe"—accepts all inserts and updates.

5. Select REFRESH

6. Resolve import issues until all records have a record status = Reject or CommitReady

7. Commit Element Group records.

8. Select REFRESH

9. Resolve any records with rec_status = Commit_Fail.  All records should have a record status = COMMIT_DONE.

14) Element_Global (EGT) Matching

1. OPTIONAL:  The EGT table usually runs very, very slowly.  If you would like to change a setting that should speed up the EGT table run-time, please see the knowledgebase (Biotics 4 Exchanger ( Admininstration ( Performance Enhancement to make ELEMENT_GLOBAL run faster in Exchanger)

2. Match all records, using the UID MATCHER (note that this might not be the first one displayed in the drop-down matcher list).  Matching may take some time—a single element_global record may have 100 or more child records, which are each matched also.

3. Re-match any records with MATCH_FAIL status, until no records have failed the matching step.

4. Review and resolve any partial matches (see Appendix).

5. Review and resolve any "collision" matches.  Exchanger will allow two incoming records to match to the same target record.  Obviously, we don't want this to happen for element records, so follow these steps to be sure you don't have any.

6. Find the column called HA_NOTES.  Sort this column (ascending) by clicking on the column header; re-sort (descending) by clicking again.

7. If any records have a collision, you will see this note: WARNING: multiple incoming records have been matched to this target record! 

8. If any of your EGTs have a collision match and you do not know how to resolve these, please contact the NatureServe science staff to consult.  Check in the botany or zoology memo to find contact information— you should directly contact the scientist listed in the appropriate memo if you need help with collisions.  Please note that once you resolve the collisions, the actual WARNING does not go away.  
9. When matching is done, look at the records with NEW status by sorting on the Match_Status column: these are the new records that NatureServe will be adding to your database.  If there are any, verify that they should be added.  Open the record into the reconciliation window by double-clicking on the row.

a. If you agree to add the element, no action is required.

b. If you don’t want to add it, choose Reject from the Matching menu.

10. All records should have a rec_status of ‘MATCH_DONE’ (or 'REJECT' if you chose to reject any new records) before moving ahead.

15) Apply rules to EGT.  The default import rules for element_global are set up to automatically accept all inserts and updates to the element_global table and its child tables (e.g. element_global_rank, eo_specs, taxon_global, animal_cag, plant_cag, etc.).  If you know there is some data in your global element records that you want to preserve, contact NatureServe for help in customizing the import rules (please submit an item to http://support.natureserve.org ).

1. Click on element_global in the tree, select the All Records checkbox and click the Apply Rule button.

2. Apply the ruleset called "dx_NHP_import_from_NatureServe."

3. All records should now have RULES_DONE in the rec_status column.

16) Review EGT reports & commit
1. Return to the project list window.  Make sure your data exchange project is highlighted, and click the Report button at the top of the window.

2. Next to the Report Templates box at the top of the report utility window, click on the "…" button.  This will show you the available report templates—select a template, then Open.  Back in the report window, click Execute Report Now.

3. Run these global-level reports, and review the results.

a. NHP_code_changes: Shows records where the ELCODE_BCD field will be changed.

b. NHP_elements_added: This is information about new elements that will be added to your database.  If you don't want to add an element for some reason, you should go back to the element_global records and manually reject the record (see Appendix).  More information can be found in the botany and zoology memos.  Note: Full species records being added because an NHP maintains a subspecies or variety are often not mentioned in the science memos.  Elements being added for other reasons will be on the science memos.

c. NHP_GrankCompare: Lists records where GRANK will be changed when you commit the element_global records.  See Appendix if you want to reject some changes to the GRANK field.

d. NHP_CDC_EGT_mod_v6: This is a new report that will check your audit logs and notify you of any plant or animal EGT or child record updates since your export (based on the date you entered in the project properties during load).  Anything returned in the report is subject to get overwritten in your database.  If there are a small number of changes you may opt to manually change them back after commit.  However, if there are a large number of changes and you would like assistance preserving this data during the exchange or if you need help interpreting the report, please submit a Support ticket.  (Note: This is a new report and has undergone testing at Central only.  Please send us any feedback you might have.)
4. You can save the reports in Exchanger format for later viewing. To save as HTML (for sharing with users who can't open Exchanger): click the "Open in Browser" button at the bottom of the page.  Then File (  Save As ( to save the HTML file.

5. Once you've reviewed the reports, return to the browse window, make any necessary edits, then commit all element_global records.  Resolve any records with rec_status = COMMIT_FAIL.  First try re-committing any failed records and if that does not work you may need to consult the knowledgebase or submit a support ticket in order to find help and resolve the commit_failed records.  All records should have a rec_status = COMMIT_DONE.  
17) Element_National (ENT) Matching, Import Rules and Commit

1. Match all records, using the Alternate key Matcher.

2. Re-match any records with MATCH_FAIL status, until no records have failed the matching step.  Record status should = Match_Done.

3. Review and resolve any "collision" matches.  Exchanger will allow two incoming records to match to the same target record.  Obviously, we don't want this to happen for element records, so follow these steps to be sure you don't have any.

9. Find the column called HA_NOTES.  Sort this column (ascending) by clicking on the column header; re-sort (descending) by clicking again.

9. If any records have a collision, you will see this note: WARNING: multiple incoming records have been matched to this target record! 

9. If any of your ENTs have a collision match, please contact the NatureServe science staff to consult.  Check in the botany or zoology memo to find contact information— you should directly contact the scientist listed in the appropriate memo.

4. Apply the "dx_NHP_import_from_NatureServe" ruleset.  This accepts all updates and inserts to element_national data.  Resolve issues until all Element_National records have a record status = CommitReady or Reject.  It is unlikely that your program maintains element_national data, but if your program does and you think ENT updates might have been made in your database since your export then please submit a support ticket to preserve ENT updates during dx upload so that we can work with you to preserve that data.
5. Commit all element_national records.  Resolve any records with record_status = Commit_Fail.  See the Knowledge Base for some common solutions to records with Commit_Fail.

6. If applicable remove any filters by choosing "None" from the filter dropdown menu at the top-right of the window.

7. All records should have a record_status = Commit_Done before moving on to the next step.
18) Element_Subnational (EST) Matching

1. Match all records, using the Alternate Key Matcher.

2. Re-match any records with MATCH_FAIL status, until no records have failed the matching step.

3. Review and resolve any "collision" matches.  Exchanger will allow two incoming records to match to the same target record.  Obviously, we don't want this to happen for element records, so follow these steps to be sure you don't have any.

3. Find the column called HA_NOTES.  Sort this column (ascending) by clicking on the column header; re-sort (descending) by clicking again.

3. If any records have a collision, you will see this note: WARNING: multiple incoming records have been matched to this target record!

3. If any of your EGTs have a collision match, please contact the NatureServe science staff to consult.  Check in the botany or zoology memo to find contact information— you should directly contact the scientist listed in the appropriate memo.  Please note that once you resolve the collisions, the actual WARNING does not go away.  
4. All records should have a rec_status of MATCH_DONE or REJECT before proceeding with the next steps in the upload.

19) Apply rules to EST
1. Explanation of the new EST apply rules process:  In order to lessen the number of manual flags the user will have to clear, we have developed a new system for applying rules to the EST records.  The new system involves running 3 separate rule sets on all of the EST records.  As always, all subnational level data will be preserved in your data with the exception of some possible changes/updates to SNAME, SRANK, and distribution fields.  However, some values in those fields may have been updated within your database while NatureServe had your data.  So, to avoid confusion, we have developed this new process.  In a nutshell, the first rule set shows how your target data will be preserved, the second rule set will show how NatureServe updates will be inserted, and the third rule set implements these changes without the need for manual confirmation.  A manual confirmation (a flag) on rule set number 3 will be present only if a situation arises where both the member program and NatureServe modified the data while NatureServe had the data for the data exchange.  


Basically, the first two rule sets serve the purpose of splitting up actions so that the user can easily tell what fields are being flagged and are slated to be rejected, versus what fields are being flagged and are slated to be accepted. The third rule set will be the final rule set and combines the first 2 rule sets so that all actions are applied at once, except that records will only be flagged if they were not caught by the first two rule sets.  

For example, an SRANK that has been updated by the member program while NatureServe had the data would get flagged by the first rule set because the NatureServe data is older than the member program data.  So, the first rule set will flag all data updates (meaning, something that is different in NatureServe’s central database) that will be rejected for one reason or another.  You will notice that these flagged fields have a red thumbs down, indicating that these updates are to be rejected.
  The first rule set is for viewing purposes only; you must move on and also apply rule sets 2 and 3 to all EST records. 

The second rule set will flag records that include updates that will be accepted.  For example, this rule set will flag records where the SRANK differs but the target SRANK value has not been modified in your database since export.  It also flags any NEW EST records that will be added to your database.  You will notice that these flagged records have a green thumbs up, indicating that these updates are to be accepted.
 The second rule set is for viewing purposes only; you must move on and also apply rule set 3, the final EST rule set in order to complete the process.


The third and final EST rule set combines the same actions as rule sets 1 and 2 except that it omits the actual flags in most cases.  Therefore, a record will only be flagged for manual confirmation if it was caught by both of the previous rule sets.  You should find that there are far fewer manual confirmations/flags to clear.    

2. Instructions for applying EST rule sets:  Click on element_subnational in the tree, select the All Records checkbox, and click the Apply Rule button.

a. First, choose the dx_NHP_import_from_NatureServe_1_UPDATES_TO_REJECT.EST rule set.  Once the rules have successfully been applied to all EST records, please peruse the flagged records to be sure that you indeed want to reject all flagged records and fields. You do not have to look at all flagged records, a sampling will suffice. 
b. Next, click the Apply Rule button and choose the dx_NHP_import_from_NatureServe_2_UPDATES_TO_ACCEPT.EST rule set.  Once the rules have successfully been applied to all EST records, please peruse the flagged records to be sure that you indeed want to accept all flagged records and fields.  You do not have to look at all flagged records, a sampling will suffice.  We suggest that you also refer to the botany and zoology memos for lists of SRANK changes, added elements, etc. that are expected to be accepted into your database by NatureServe scientists.  If you decide you want to reject something that is slated to be accepted, please make a note of it (import_detail_id of record or some other detail so you can find it later) for use after the next step. If you change the green thumbs up to a red thumbs down at this point, your change will be overwritten by the third ruleset.
c. Click the Apply Rule button once again and choose the  dx_NHP_import_from_NatureServe_3_FINAL.EST rule set.  If you were happy with the results of rule sets one and two and do no wish to alter the state of any records (e.g., you don’t want to reject something that was slated to be accepted), then you can continue to the next step.  If you did want to alter a record or field, please find the record and do so at this time (if you need help, contact Biotics support).  
3. All records should now have RULES_DONE or RULES_FLAG in the rec_status column.

20) Run EST reports & clear rules flags

1. Return to the project browse window, highlight your project row, and open the report utility.

2. There are two element_subnational reports: NHP_sname_changes and NHP_srank_changes.  If you want to save these results be sure to save as an html document so that others can easily view the output.  Review the results; more information can be found in the botany and zoology memos.

3. A third element_subnational report was recently added: NHP_CDC_TSD_mod_v1.  This report will provide current distribution data for all EST records which have changed since your data exchange export (based on the "Last Exchange" date you entered in the project properties).  Any plant or animal ESTs on this report will have their distribution data flagged by the new ruleset with the default action to accept the changes (green thumb).  If you do not want the data overwritten and need guidance please refer to the appendix or contact NatureServe Support (http://support.natureserve.org/).
4. Now clear the rules flags on the EST records.  Reopen the import project, and open element_subnational.  Sort on the rec_status column to find any records with RULES_FLAG status or create a filter.  It is entirely possible that there will be no flagged EST records in light of this new EST rules process.  
5. If you do find flagged records, please open each of those records and look at what field was flagged for review.  Decide whether or not to accept the incoming values, based on the reports you just ran and the science memos sent by NatureServe.  Accept or reject the incoming values, and remove the red flags from those fields (see Appendix).  Please note that if you accept an SRANK field, the ROUNDED_SRANK field will automatically also be accepted (e.g. you will not need to manually accept the rounded srank field as well).  If you decide to reject any incoming values listed in the memos, please inform the appropriate NatureServe science staff member working on your exchange, so we can note the disagreement or make the changes in the central databases as well.

6. All records must have RULES_DONE in the rec_status column before you can proceed.
21) Commit ESTs

1. Once all element_subnational records are rules_done and the FINAL EST rule set has been applied, you're ready to commit the EST records.
2. Click on the element_subnational page on the browse tree, select the All Records checkbox, and click the Commit button. Resolve any records with record_status = Commit_Fail; all records should have a rec_status of Commit_Done.  See the Appendix at the bottom of this document or the Knowledgebase for some common solutions to records with Commit_Fail.

3. When all records are committed you can then move on to the very last step.
22) Please check the science memos to see if you have any Type 3 deletions.  If you do, please follow these instructions.

Type 3:  Deletion where new EO parent is forthcoming 

1. Perform these steps after committing all data in Exchanger.  

2. Element deletions that appear in these lists have EOs and Source Features attached to them.  These EOs and Source Features must be re-parented before the deletion can take place. 

3. Open the Tracker application, and find the Element Global Tracking records listed in the memos.  When you are searching for an Element, be sure to have the ‘all levels’ and the ‘include related scientific names’ options chosen.  This way you can also see related infra-specific species that you may want to know about.  Open the first EGT by double-clicking on the row.

4. Check for EOs.  Under the File menu, choose Open ( Element Occurrences.

5. If any EO records are opened, you must re-parent these EOs before proceeding.  You can re-parent EOs in Tracker.  Please follow the instructions in the appendix of this document (re-parenting an element occurrence record) if you need help with this.  

6. If a "no related element occurrence records" dialog box comes up, check for Source Features.  File menu ( Open ( Source Features.

7. Please re-parent all Source Features using a SQL update command before proceeding.    
8. Once re-parenting of all attached EOs and source features is completed, you may now proceed with the deletion of this element. 

9. Delete the element.  Under the Edit menu, choose Delete.  Click Yes to confirm the delete.  The associated ENT and EST will also be deleted as well as any child tables of EST, including ESR and CAS.  Repeat all of the steps to check if EOs need to be re-parented for all species in the delete sections of both the zoology and botany memos.

Repeat these steps for all elements listed in the Botany and Zoology memos under the Type 3 deletion category.  

Once you are done with your type 3 deletions (or you never had any to begin with) you are done with the post-exchange upload!
Clean-up steps
1. Once you are confident that you've processed all of the records, you can purge the data from your holding-area tables.  This will permanently delete the project, which will reduce the overall size of your database.

2. Purge the project from the holding area.  Just open up the Exchanger import tool, and click on the row for your data exchange import project (just to highlight the row).  Click the Purge button at the top of the window.  It may take quite a while to get rid of the project, but just let it run.  Also, it's fine to stop and re-start the purge if you need to; it will just pick up where it left off.

3. In order to free up space in your BIOTICS_DX_INDEX tablespace, you'll need to rebuild the indexes.  There's information on how to do that in the Knowledge Base, in Article Biotics492  (Biotics 4 Exchanger ( Admininstration ( Tablespace Admininstration).

4. Run a database integrity check.
APPENDIX: Some Detailed Procedural Instructions
Solution to the most common type of commit_fail error:  If you have a commit_failed record that includes in the error message any of the following alternate key unique constraint violations, please proceed with the following instructions.

	Common Unique Constraint Violations:

All of these relate to the OU_UID and SEQ_UID fields within the record

	REFERENCE_AK2

	HIGHER_CLASS_UNIT_AK1

	SCIENTIFIC_NAME_AK1

	SCIENTIFIC_NAME_REF_AK2

	ELEMENT_GROUP_AK2

	ELEMENT_GLOBAL_AK3

	ELEMENT_NATIONAL_AK2

	ELEMENT_SUBNATIONAL_AK3

	SYNONYM_GLOBAL_AK2 (child table of ELEMENT_GLOBAL)

	SYNONYM_NATIONAL_AK2 (child table of ELEMENT_NATIONAL)

	SYNONYM_SUBNATIONAL_AK2 (child table of ELEMENT_SUBNATIONAL)


When assessing whether or not you have one of these errors, be sure to pay special attention to the AK number.  For example, AK2 and AK3 mean different things depending on the table in question.   If you receive any of the above unique constraint violations, please apply the following fix to the table or child table having the problem.  For example, if an ELEMENT_GLOBAL record is failing, and you open the record up and get a message like ‘commit failed in child record’, and you see that the child record that failed is SYNONYM_GLOBAL, you must highlight this child table and apply the fix ONLY to the child table (not the top level table).  Only apply the fix to the record that is actually causing the failure.  Sometimes the top level record is causing the problem, while, other times the child record is to blame.  Basically, you will be editing the OU_UID field within the problem record in order to resolve this problem.   
4. Open the failed record in view and edit mode.

4. Locate the record that is causing the failure (find where the AK unique constraint violation message occurs).  Highlight that table or child table within the view and edit mode so that you can see the error message and all fields within the table.

4. Locate the field ending in ‘OU_UID’ for the problem record.

4. Click on the pencil icon next to the OU_UID field and say yes to the prompt about’ do you want to lock and edit this record’.

4. Once the edit window opens, delete the value that exists in the field.  Then, type a ‘1’, go back and place the cursor in front of the ‘1’ and type a ‘-‘sign (Exchanger will not let you enter the ‘-‘ sign first).

4. Apply the change and close the edit window.  

4. Once back in view and edit mode, click on the save icon to save the change you made to this record.

4. Try to commit the top level record again.

4. Repeat for any other stubborn record that has the same unique constraint violation as listed in the table above.    
Problems deleting Element records: The following is an example of how to address an ‘error deleting element.    
If you encounter an error like Delete Element: Error deleting element: You may not delete this record because it is related to other information in the database. The following tables have data related to this record: TAXON_GLOBAL.
When you get a message saying that the Element Global Tracking record can't be deleted because it's linked to a TAXON_GLOBAL record, the problem is that the EGT you're trying to delete is linked as a parent species to another EGT record. Either it's correctly linked because the other EGT is a subspecies or variety, or it's incorrectly linked because of a data problem. In either case, the solution is to (a) find out what other EGT it's linked to and (b) get rid of the link.
 

To find the other EGT, do the following query:

select taxon_global.element_global_id
from taxon_global
where taxon_global.parent_species_id = the element_global_id of the record you're trying to delete
 

When you find the other element_global_id, check to see if the record is a subspecies of the element you are trying to delete. If it is, then maybe you don't really want to delete the EGT after all, because it, and other related records like the EGR, may contain data that also applies to the subspecies. Check with your botany staff or our data exchange folks if you have questions about deleting or keeping it.

 

If the other element_global_id is not a subspecies (bogus data), or if you decide to delete the full-species record anyway, first you need to clear out the taxon_global.parent_species_id field. You can do that in the subspecies EGT record on the Classification tab by clicking the X next to Parent Species, or you can run the following SQL update:

 

update taxon_global
set parent_species_id = null, rec_last_mod_user = 'your_user_name'
where element_global_id = the id you found by running the query above;
 

Then, you should be able to delete the EGT.
Re-parenting Element Occurrence Records

Unlinking one or more EO records from one EST and re-linking them to another EST can be done through the GUI by using the “Change Associated Element” option under “Tools” on the EO working list menu bar.
Procedure

1. With one or more EO records highlighted on the EO working list, select Tools – Change Associated Element. 
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The Element Find window opens, restricted to subnational results. Search for an element and select an EST from the results (multi-select is disabled). Click OK. 
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2. Summary window appears. (Print works!  The report is sent to your default printer.) 
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In the case shown above there were no EOs previously associated with the new EST.  Therefore, the updated EO Number is the same as the original EO Number. However, if there are EOs, the EO Number of the EOs being reassigned are updated to the next available number. The changed numbers appear in boldface.
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3. The working list is updated with new Element name and EO Number, as is the EO detail record. The associated Source Feature(s) are also relinked to the new EST. 

Points to Remember

1. The application will not prevent you from reassigning EOs to an EST for a different Subnation.  This may be a concern in multijurisdictional databases.

2.   If EOs from more than one jurisdiction are being switched to a different element, the relinking must be done in batches, subnation by subnation.
Manual Match records of any type: Double click the record in the holding area to bring up the reconciliation window.  Click the Matching menu, and scroll down to Manual Match.  If there are candidate matches, the tool will provide those to you.  If there are not, you will have to look up the record ID in B4 for that you wish to manually match to and enter this number in the “New ID” box that appears.  After entering the id number, click Detail to see if you typed the number in correctly.  Details will show you the fields in the target record you will manually match to.  If you discover you have incorrectly performed a manual match, no problem, repeat the process with the correct candidate match or target record ID.

Evaluating partial matches:  If a matcher finds several target records that partially match an incoming record, they are stored as candidate matches.  The match_status column will say “Partial” for these records.  Open the reconciliation window by double-clicking on the row in the browse window.  Candidate match(es) will be listed at the top of the screen.  You can view the target records to evaluate whether the match should be accepted.  If you accept the candidate match by clicking ‘select match’, then the match_status will be set to manual_match.  If you don’t feel that any of the candidates are an appropriate match, you need to set the match status to new: from the Matching menu, choose New.

Manually setting a record to NEW:  You can manually change the match status of a record to NEW.  Open the record by double-clicking it in the browse window.  Under the Matching menu, choose New.
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Manually rejecting a record:  If you decide you want to reject a holding-area record, for whatever reason, you can manually change its match status to REJECT.  Open the record by double-clicking it in the browse window.  Under the Matching menu, choose Reject.  This will entirely reject the incoming record—no changes will be made to your target database.

Manually rejecting a field:  NOTE: this can only be done after rules have been applied to a record!  Open the record in the View & Edit window.  You'll see a thumbs-up/thumbs-down icon next to each field, indicating whether the incoming data will be accepted or not.  Click on the green thumbs-up icon next to the field you want to reject.  It will ask if you want to lock the record for editing—answer Yes.  Once you've changed the icon to a red thumbs-down, save the record by clicking the Save button at the top of the window.  No changes will be made to the target field when you commit the record.

Removing a red flag from a field or record:  Flags get set by the import rules, to force the user to review an incoming record or value.  Once you have reviewed the data and decided which data to accept, click the "Lock Record for editing" button at the top of the record.  Click on the thumbs-up/thumbs-down icon (if you want to change the accept/reject status)—then, remove the flag by clicking on the red flag icon.  It will change to a green flag, meaning that the user has reviewed the data.  Save the record.

Exporting Records from your Biotics:  Instructions
Please note that these are very general instructions and that their purpose is just to demonstrate the overall process.  The specifics of each export will differ.

1. Make working lists of the records you want to export.  You have to do this step in Tracker, either using the Find tool or the Query Builder.

a. You must save the working lists as “shared” lists, or Exchanger will not be able to see them.

b. Note that you will also have to make working lists of related records you want to send.  For instance, let us say that you have developed some new EGRs to send to NatureServe, and you want to send the reference records that go with those EGRs.  You will need 2 working lists; one for EGTs and one for the references.  The “generate working list” Tracker functionality (located under the Lists menu) can be very helpful with this.

c. Related to this, you have to have working lists for each logical record level you want to export such as scientific name, references, EGT, ENT, EST, and element group.

2. Configure the Exchanger export tool

a. The export tool will open in a blank project, so the first step is to either add “tasks” for each of the kinds of records you want to export or to open an export template and modify it to fit your needs.

i. In the menus, go to Task(New(and then choose the kind of record you will be exporting (e.g. Element Global, Reference, etc,).  This will open up a new task of the type you choose.

ii. In the fields tab, you will see a browse tree.  You can expand and collapse pieces of the tree by clicking on the key icons   .  All of the fields and child tables are nested under the main record.  Check the boxes next to the fields and tables you want to include in your export.  Required fields will be filled in automatically.  

iii. Change to the Records tab.  Here, you can include or exclude records from your export, based on working lists you made in step 1 from the first drop-down menu under Include.  

iv. Click OK to save your changes and return to the main project window.  

b. Add more tasks as needed until you have all of the types of records you intend to export.

3. Optional step:  Preview the results

a. You can see the data before it is exported in order to make sure you have everything configured the way you intended.  Click on a task, then go to the menu:  Task(Browse selected task.

b. This will bring up a grid showing which records you have selected.  You can click on columns to sort if you wish.

c. If you would like to see the detailed contents of any record then double-click on a row in the grid.  This will show you a nested view of the record as well as its fields and child tables.

d. Close the preview by choosing Exit from the File menu.

4. Run the Export

a. When you are satisfied that everything is ready to go, start the export by clicking the green arrow button or by choosing Project(Run Export.

b. Choose where you would like to save the results and a file name, then click save.  You will see a progress window that will show you what is going on.  Please note that the progress bar may say 100% completed, but until you see ‘export done’ on the bottom portion of the progress window, your export is not complete.  

c. When the export is finished (no green colors will appear in the progress window and you will see ‘export done’), click Close to return to the project window.  

5. The End Result is one zip file containing a bunch of related XML files.

a. You can open the zip file and see what was exported; the XML files inside can be viewed with a web browser or text editor.

Note that there is a summary file in the zip file that contains helpful information (exportSummary.xml).  This file will show you what records were included in the export, who exported the data, a count of the number of records exported, etc. and can be very helpful in confirming that you exported all the items you intended to export.  
� Although ROUNDED_S_RANK is not flagged or marked to be rejected, Exchanger will not overwrite the new ROUNDED_S_RANK.


� ROUNDED_S_RANK is not marked to be accepted because it will be recalculated based on the new incoming SRANK.
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